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Ghost Pilots play an important role in implementing simulation training in the En Route 
Automation Modernization (ERAM) Test and Training Lab (TTL) at En Route centers.  
Simulation exercises are a key component of new controller training.  Simulation 
exercises are also used for new systems training. 
In general, Ghost Pilots perform two roles during an exercise: 

• Ghost Pilots simulate aircraft pilots.   
o They conduct all air-to-ground voice communications with the controller 

working at the training sector.   
o They use ATPilot software to enter target control commands in response 

to clearances issued by the controller.   
 An example would be a clearance to climb to a new altitude. 

o They use ATPilot software to communicate with the controller using 
Controller Pilot Data Link Communications, or CPDLC.  
 CPDLC is a digital text communication option used with properly 

equipped aircraft instead of voice. 
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• Ghost Pilots simulate adjacent sector controllers.   
o They conduct all ground-to-ground communications with the controller at 

the training sector.   
o They use ATPilot software to enter ERAM commands required for the 

scenario.   
 An example would be accepting handoffs from the controller. 
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The design of the course assumes students are familiar with Air Traffic operations and 
phraseology.  The focus of the course is ATPilot functionality.   
ATPilot is a Graphical User Interface (GUI) for entering ATCoach commands.   
ATCoach is the simulation software that connects to the TTL ERAM channel.  

• ATCoach feeds simulated surveillance data to the TTL ERAM channel for display 
at controller positions. 

o Example: When a Ghost Pilot interacts with the ATPilot display to select a 
new altitude for a target, it converts the action into an ATCoach command.  
ATCoach then executes the command, and the simulated surveillance 
data reflects the altitude change. 

• ATCoach injects ERAM commands as if entered at the facility. 
o Example: When a Ghost Pilot interacts with the ATPilot display to accept a 

handoff, ATPilot converts the action into an ERAM handoff accept 
command.  ATCoach then injects the command as if entered at the 
receiving sector. 
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Simulation developers use software called Scenario Generation Tool (SGET) to create 
scenarios.  Scenarios are nothing more than a series of ATCoach commands injected at 
specified times.  Anything a Ghost Pilot can do can also be scripted in the scenario.  
Scenario developers script as much of the exercise as possible to minimize the Ghost 
Pilot workload.   

• Typically, any event with a known time will be scripted in the scenario.   

• The Ghost Pilot handles events that are dependent on a controller instruction. 
  



LESSON 1: Setting Up the Ghost Pilot Display  

Setting Up the Ghost Pilot Display   
Page 6  FAA55149002-LP01/V2019.05  

Slide - 4. 

  
 

  



LESSON 1: Setting Up the Ghost Pilot Display 
 

  Setting Up the Ghost Pilot Display  
FAA55149002-LP01/V2019.05 Page 7 

Slide - 5. 

 
 

There are two evaluation components: 

• A comprehensive end-of-course performance checklist administered by an 
instructor.   

o The instructor will provide feedback as needed. 

• A comprehensive end-of-course knowledge test administered via eLMS.   
o After all questions are attempted, a review screen will provide feedback for 

any missed questions, and an alternate question must be answered 
correctly. 

o The student will need to correctly answer a question on each topic to 
complete the course.   

 
 
  



LESSON 1: Setting Up the Ghost Pilot Display  

Setting Up the Ghost Pilot Display   
Page 8  FAA55149002-LP01/V2019.05  

Slide - 6. 

 
 

This is a 4-day course combining instructor-led lessons, part-task scenarios, operational 
scenarios, and performance checks. 
 
Day 1 consists of the following lessons: 
 

Lesson 1 – Setting Up the Ghost Pilot Display (with Part Task scenario) 
Lesson 2 – Interpreting Ghost Pilot Displays (with Part Task scenario) 
Lesson 3 – Routine Target Simulation Tasks (with Part Task scenario) 
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Day 2 consists of the following lessons: 
Lesson 4 – Adjacent Sector/Facility Tasks (with Part Task scenario) 
Lesson 5 – Specialized Target Simulation Tasks (with Part Task scenario) 
Lesson 6 – Exercise Support Functions (with Part Task scenario) 

There will also be a comprehensive Part Task practice scenario. 
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Day 3 consists of five operational scenarios with headsets. 
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Day 4 consists of the following: 
A final operational scenario with headsets. 
A Part Task practice scenario that covers all the performance objectives in the 
course. 
A Performance Skills Check scenario that covers all performance objectives in 
the course.  
A comprehensive knowledge test delivered via eLMS. 
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The first topic quickly introduces the main Ghost Pilot display components.   
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The first topic quickly introduces the main Ghost Pilot display components.   
The Header, or Identification bar, is at the very top of the display.  It identifies the TTL 
exercise number, the pilot position number, and the training sector being supported.  In 
this case, the exercise number is 1, the pilot position number is 1, and the training 
sector is ZDC 4. 
The window menu and minimize/maximize pick areas should not be used by Ghost 
Pilots. 
The Menu bar is immediately below the Header and is used to access six drop-down 
menus. 
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Below the menu bar are the toolbars.  Ghost Pilots can customize which toolbars are 
displayed, as well as their location.  Note that the default location for the Macro toolbar 
is almost at the bottom of the display. 
The map display area depicts the scenario airspace.  Ghost Pilots can customize the 
map elements (e.g., sectors, fixes, or airways) that are displayed. 
Targets currently in the exercise appear on the map display.  The targets are very 
similar to the data blocks shown on the controller’s display.  The Ghost Pilot can 
customize default target characteristics that apply to all targets, as well as the 
characteristics of a single target. 
There are nine views that provide scenario information.  Many also provide access to 
target control menus.  In this example, the Selected Aircraft Information Area is shown. 

On the bottom of the display is the scenario Status Information Bar. 

In the next few slides, we will look at some of these elements more closely. 
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The Menu Bar provides access to six drop-down menus. 
The File menu provides: 

• Printing and screen capture functions not typically used by Ghost Pilots. 
• Preference Set management options. 
• The ability to load macros.  This will be covered in a later lesson. 
• An Exit option not typically used by Ghost Pilots. 

The Control menu provides controls to start, pause, or end an exercise.  To start an 
exercise click on Run.  This should only be done after coordination with all exercise 
participants. 
The Prompts menu provides options for managing Ghost Pilot prompts.  Prompts are 
special instructions from the scenario developer to the Ghost Pilot that appear at the 
time specified by the scenario developer.  An example might be a prompt to declare an 
emergency.  Ghost Pilot prompts will be covered in a later lesson.  
The Messages menu provides options for managing various types of messages. An 
example is system error messages. These options will be covered in later lessons. 
The Toolbars menu is used to display or hide the five toolbars. 
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The Help menu provides ATPilot software level information (About SDD…) and access 
to various ATPilot related user manuals. (SDD is Situation Data Display.)  The manuals 
are: 

• AT Pilot Online Help – Opens the ATPilot Manual Online Help Dialog. 

• Control Commands – Opens a reference manual of ATPilot Runtime Control 
Commands.   

• Operational Commands – Opens a reference manual of ATPilot Operational 
Commands. 

• Scenario Data Formats – Opens a reference manual of scenario formats for 
scenario developers. 

• Site Data Formats – Opens a reference manual of site data formats for scenario 
developers. 

Many of the menu options are also accessed from toolbars or other context-sensitive 
menus. 
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There are five toolbars: 
The Range toolbar is used to set the map range.  
The Views toolbar is used to display or hide the nine Ghost Pilot views. 
The Display toolbar provides options for customizing Ghost Pilot display characteristics. 
The Macro toolbar is used to create and manage macros.  
The Exercise Control toolbar is used to start, restart, pause or stop an exercise.  It can 
also be used to change the exercise simulation speed. 
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The three most frequently used buttons on the Exercise Control toolbar are Run, 
Terminate, and Pause.  These are the same options available in the Control drop-down 
menu. 
Grayed out options are unavailable. 
The various other buttons provide more specialized controls that will be covered in a 
later lesson. 
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There are three context-sensitive menus that appear when the Ghost Pilot right-clicks 
on specific parts of the display. 

• Map Display menu 
• Data Block menu 
• Target Control menu 

Right-click on any blank portion of the map to display the Map Display menu.  This 
menu provides options for customizing the map.  We will cover these options later in 
this lesson. 
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Each target has a position symbol that shows the current location of the target.   

The target’s location and altitude are used to generate the simulated surveillance data 
that is sent to the TTL ERAM channel for display at the controller positions. 

Each target also has a target label that shows, among other things, the callsign, altitude, 
speed, and heading.   

Right-click on the position symbol to display the Data Block context-sensitive menu.  
This menu provides options for customizing the characteristics for the selected target. 
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The third context-sensitive menu is the Target Control menu.  Right-click on the callsign 
to open the menu.   
This menu provides options for performing many target control tasks.  Examples include 
changing the target route, placing the target in hold, and changing the beacon code 
being squawked by the target.  
The menu also provides options for performing adjacent sector tasks.  Examples 
include initiating or accepting handoffs, and making point outs. 
 
 

 

  



LESSON 1: Setting Up the Ghost Pilot Display  

Setting Up the Ghost Pilot Display   
Page 24  FAA55149002-LP01/V2019.05  

Slide - 20. 

  
 

Dialog boxes provide a Graphical User Interface (GUI) for making entries.  From here 
on, we will refer to dialog boxes as dialogs. 
In this example, we see the Heading Change dialog.  The Ghost Pilot selects the 
desired heading, then clicks the Ok button. The software then converts that action into 
the ATCoach command needed to make the target turn to the selected heading. 
ATPilot contains a large number of dialogs and we will cover all of them throughout this 
course. 
When making entries in a dialog, the user can move between fields by either using the 
Tab key or clicking on the desired field.  
Click the Ok button or press the Enter key to execute the command. 
Click the Cancel button to cancel the entry process and close the dialog.  
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There are nine views (windows) that provide scenario information.  Many are also used 
to perform Ghost Pilot tasks.   
 
The Active Aircraft List, or AAL, provides information about all currently active targets in 
the scenario.  
 
The Future Aircraft List, or FAL, provides information about targets that will become 
active later in the scenario, for example, departures or air-starts. 
 
The Command Line is used to manually enter ATCoach commands.  Most ATCoach 
commands are automatically generated using the ATPilot GUI.  If a Ghost Pilot knows 
the syntax, the ATCoach commands can be manually entered.  Remember that the 
Help drop-down menu provides ATCoach command documentation. 
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The Prompt List displays prompts created by the scenario developer that direct the 
Ghost Pilot to perform a certain action at a specified time.  An example would be to 
contact the controller and request a new altitude.  Prompts may include ATCoach 
commands to reduce Ghost Pilot workload. 
 
The Pending Commands view displays commands that will be executed after a certain 
condition is satisfied.  For example, the target will proceed direct to a fix after a certain 
altitude is reached. 
 
The Selected Aircraft Information Area, or SAIA, provides information about the 
currently selected target.  Click on a target callsign to select it. 
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The Message Area/Role Play view displays system messages, for example, error 
messages explaining why a command was rejected.  The view is also used to access a 
dialog used for entering ERAM messages when a Ghost Pilot is performing adjacent 
sector tasks. 
 
The ERAM Flight Plan Display view shows the ERAM flight plan (i.e., the flight plan 
seen by the controller) for the desired target. 

The CPDLC Message view is used to manage CPDLC communications. 

• CPDLC is a digital text communication option that controllers may use instead of 
voice.  Aircraft must be properly equipped to communicate via CPDLC.  CPDLC 
must also be enabled at the facility.  

• A CPDLC equipped aircraft must log on and establish a session (i.e., connection) 
with the US CPDLC ground system in order to use CPDLC.  The entire US 
ground system is considered a single data authority, KUSA.  There are two types 
of sessions: 
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o A Current Data Authority (CDA) session means the aircraft can exchange 
the full set of CPDLC messages with KUSA. 

o A Next Data Authority (NDA) session means the aircraft has established a 
session in preparation for using CPDLC.   
 Example 1:  Aircraft inbound from Canada will establish an NDA 

session with KUSA so when they enter US airspace they can 
seamlessly transition to a CDA session.   

 Example 2:  Aircraft that logon to CPDLC while in flight will have an 
NDA session for a short period as part of the CDA session 
establishment process. 

• Controllers can uplink (i.e., send the message from the ground system to the 
aircraft) a variety of clearances and instructions.  The pilot sees the clearance on 
an electronic display and can accept or reject the clearance.  

• Pilots can downlink (i.e., send the message from the aircraft to the ground 
system) responses to the controller uplinks and a limited number of requests.  
Controllers can accept or reject the request. 
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The Status bar, located at the bottom of the display, shows the following information 
from left to right: 
 

• Current Simulation Time (time displayed at the controller positions)  
• Relative Simulation Time (how long the scenario has been running) 
• Current Simulation State (Running or Frozen) 
• Map Center Coordinates 
• Map Range 
• Current Mouse Pointer Coordinates 
• Selected Target 
• Site File name 
• Scenario File name 
• Altimeter (if scripted in the scenario) 
• Temperature (if scripted in the scenario) 
• Altitude Filters (based on Ghost Pilot filter selections to be described later) 
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This section covers setting up the Map Display.  The following map elements can be 
customized: 
 

• Map Layers – Layers include such things as sector boundaries, navigation aids, 
and airways. 

• Map Range 

• Map Center 

• Compass Rose – These are heading marks around the edge of the map. 

• Range Rings 

• Weather 

• Map Home Location – The map center when the scenario starts. 
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Map layers are graphic elements that can be added or removed from the map display.     
Examples include sector boundaries, navigational aids, and airports. 
 
Map layer data is derived automatically from local adaptation. 
 
Click on the Map Layers icon (i.e., the globe icon) on the Display toolbar to access the 
Map Layer Selection dialog used for displaying or hiding map layers.  There is also an 
option on the Map Display menu. 
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To display a map layer, click on the Visible checkbox next to the desired layer.  If the 
Visible checkbox is selected, click on it to remove the layer from the map.  For 
example, click on the Visible checkbox next to APT to display airport icons.   
 
Note: Local adaptation determines what is contained in a layer. Some layers may be 
empty. 
 
An identifying label can also be displayed or removed in the same manner.  The default 
setting for the Labels checkboxes is checked.  Labels will only be displayed if the 
associated layer is being displayed.  
 
The All button selects all Visible column checkboxes.  Note that doing so can result in a 
cluttered display. 
 
The None button de-selects all Visible column checkboxes.   
 
Click the Ok button to implement all changes and close the dialog.  Pressing the Enter 
key is equivalent to clicking the Ok button. 
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Click the Cancel button to close the dialog without making any changes.  Note that 
closing the window (clicking the X in the upper-right corner) has the same result as 
Cancel.  
 
The All, None, Ok and Cancel buttons behave the same in all dialogs and will not be 
described again.  
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The individual items displayed when a layer is selected can be customized.  To do so: 
 

1. Right-click on the desired layer name. An Edit button will appear. 
2. Click the Edit button.  The desired Map Layer Editor will appear. 
3. Select all desired checkboxes. 
4. Click Ok. 

 
Map items can also be hidden by right-clicking on a displayed map element and 
selecting Hide.  To re-display, return to the Map Layer Editor and use the above 
procedure. 
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Use the Range toolbar to set the desired map range.  There are multiple options: 
 

• Click on the Zoom In or Zoom Out icons.   
o Each Zoom In click will result in a 10% decrease in the current range. 
o Each Zoom Out click will result in a 10% increase in the current range. 

• Type the desired range into the range input box and press Enter.   
o You can also populate the range input box by clicking on the pull-down list 

button to the right of the input box, then clicking on a previously entered 
value. 

• Slide the Range slider bar to the desired range.  
Other options for changing the map range will be discussed later in this lesson. 
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The easiest way to move the map is to click-and-drag.  To do so: 
1. Hold down the left mouse button on any blank part of the map.  The cursor will 

change to indicate it is in “move” mode. 
2. While continuing to hold down the left mouse button, move the cursor to the 

desired location. 
3. Release the left mouse button. 

Other options for moving the map will be discussed later in this lesson. 
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Heading tick marks can be displayed along the edges of the map.  Every 10th mark is 
labelled. 
Click on the Compass Rose icon on the Display toolbar to display/remove the heading 
marks. 
Other options to display/hide the Compass Rose will be described later in this lesson. 
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Range rings can be displayed.  The distance between rings can be customized.  We will 
describe options for doing so later in this lesson. 
Click on the Range Ring icon on the Display toolbar to display/remove range rings. 
 
 
 
  



LESSON 1: Setting Up the Ghost Pilot Display 
 

  Setting Up the Ghost Pilot Display  
FAA55149002-LP01/V2019.05 Page 41 

Slide - 35. 

 
 

Scenario developers can create simulated weather data for the scenario.  This includes 
altimeter data, winds, and precipitation at three intensities.  Only the simulated 
precipitation data displays on the map. 
Click on the Weather icon on the Display toolbar to display/remove precipitation.   
Alternative methods to manage the display of weather are covered later in this lesson. 
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The Properties dialog has five tabs used to customize characteristics of the Ghost Pilot 
display.  In this section, we will cover the Display tab. 
Click on the Properties icon to open the Properties dialog.  Click on the Display tab to 
access the map display options.   
There are six sections: 
 

• Window 
• Range rings 
• Compass rose 
• Selected AcInfo Area 
• Range/bearing lines 
• Graphical Commands 

 
The Apply button will apply any changes and leave the dialog box open. 
The Reset button will restore the last set of applied settings and leave the dialog box 
open. 
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The Window panel provides options to set the map range, map center coordinates and 
map Home location coordinates. 
To set the map range: 

1. Enter the desired range in the Range (nmi) input box.  The abbreviation “nmi” 
stands for nautical mile. 

To set the map center point or Home location points: 
1. Enter the desired coordinates in the appropriate input box. 

or 
1. Click on the […] button next to the desired input box.  A dialog containing a list of 

navigation points will be displayed. 
2. Click on the desired navigation point to select it. 
3. Click the Ok button on the dialog.  This will place the navigation point coordinates 

in the input box and close the dialog.  
Click the Apply or Ok button on the Properties dialog once all desired changes have 
been made. 
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The Range rings panel provides options for managing range ring characteristics.  The 
steps to make a change are the same as in the Window panel. 
The Enable range rings checkbox is used to display/remove range rings. 
The Separation (nmi) input box is used to specify the distance between range rings. 
The Center point input box is used to specify the range ring center point.  The button to 
the right of the input box behaves in the same manner as the center point of the map. 
The Color button is used to specify the color of the range rings.  The button color 
represents the current range ring color.  To change the color: 

1. Click the Color button. The Select Color dialog will appear. 
2. Click on the desired color. 
3. Click on the Ok button on the dialog.   

Click the Apply or Ok button on the Properties dialog once all desired changes have 
been made. 
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The Compass Rose panel provides options for managing Compass Rose 
characteristics. 
The Enable compass rose checkbox is used to display/remove heading tick marks and 
labels. 
The Mark color button is used to specify the color of the tick marks.  The button color 
represents the current color. 
The Text color button is used to specify the color of the heading labels that appear 
every 10 tick marks.  The button color represents the current color. 
The Magnetic North and True North radio buttons are used to specify whether the tick 
marks should offset to reflect the magnetic effects at the facility.  Only one button can 
be selected at a time. 
Click the Apply or Ok button on the Properties dialog once all desired changes have 
been made. 
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There are three additional panels in the Display Tab of the Properties dialog.   
The Selected AcInfo Area panel is used to select the Selected Aircraft Information 
Area (SAIA) view color. 
The Range/bearing lines panel is used to select the color and font used with 
range/bearing lines.  To select font characteristics: 

1. Click the appropriate Font selection button […] . The Select Font dialog will 
appear. 

2. Select the desired font. 
3. Select the desired size. 
4. Select the desired style. 
5. Click the Ok button on the Select Font dialog. 

The Graphical commands panel is used to select the color and font of a graphical 
reroute.  The process is the same as above.  
Click the Apply or Ok button on the Properties dialog once all desired changes have 
been made. 
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The Map Display menu is one of three context-sensitive menus introduced earlier.  It 
provides options for managing the map display.   
Right-click on any blank portion of the map to open the menu. 
The options, and their functions, are as follows: 

• Click on Set window center to center the map at the cursor coordinates of the 
right-click. 

• Click on Set range rings center to center the range rings at the cursor 
coordinates of the right-click. 

• Click on Set Window Home to set the map home at the cursor coordinates of 
the right-click.  This saves the coordinates but does not move the map.  

• Click on Move to Window Home to move the map center to the current Window 
Home coordinates. 

• Check/uncheck the Compass checkbox to display/remove the Compass Rose 
(i.e., heading tick marks). 
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• Check/uncheck the Range rings checkbox to display/remove range rings. 

• Check/uncheck the Weather checkbox to display/remove simulated precipitation. 

• Check/uncheck the System traffic checkbox to display/remove targets that are 
not controlled by a Ghost Pilot.  Typically, these are targets in adjacent sectors 
that are added by the scenario developer for realism but do not affect the 
problem.   

• The Map layers… option opens the Map Layers Selection dialog. 

• The Target filters… option opens the Target Filters dialog.  We will describe this 
dialog later in this lesson. 

• The Properties… option opens the Properties dialog. 
The Add Target… and Find Target options will be covered in a later lesson. 
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The Weather tab in the Properties dialog is used to manage weather display 
characteristics.  Use the Display toolbar to open the dialog. 
Click on the Weather tab to display the available options.   
The Enable weather checkbox is used to display/remove weather. 
The Light intensity button is used to specify the color representing light precipitation.  
The button color is the currently selected color. 
The Medium intensity button is used to specify the color representing medium 
precipitation.  The button color is the currently selected color. 
The Hard intensity button is used to specify the color representing heavy precipitation.  
The button color is the currently selected color. 
The Transparency slider bars are used to establish the transparency level for each 
type of precipitation. 
Click the Apply or Ok button on the Properties dialog once all desired changes have 
been made. 
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Default target characteristics are the characteristics that apply to targets when they first 
appear.  The following default target characteristics can be specified: 

• Speed vectors depict the predicted target position at a future time 

• Route lines depict the current target path 

• Histories depict a number of the most recent target positions 

• A Halo is a circle around the target position symbol 

• The type of target label and label offset direction from the position symbol  

• Target color can be set for different target conditions 

• The target label font size  
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Default target characteristics are primarily set in the Targets tab of the Properties dialog.  
Use the Display toolbar or the Map Display menu to open the dialog. 
Click on the Targets tab to display the target options.   
There are six panels: 

• Speed vector 

• Route 

• History 

• Halo 

• Label 

• Colors 
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Speed vector lines show where a target will be if it continued on a straight path at its 
current speed. 
To display speed vectors enter a number of seconds greater than zero in the Length 
(sec) input box.  The system will calculate the target position in that number of seconds, 
and draw a line from the current target position to that point. 
To remove speed vector lines, enter a value of zero seconds. 
Click the Apply or Ok button on the Properties dialog once all desired changes have 
been made. 
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Route lines depict the remaining portion of the current ATCoach route.  It is equivalent 
to the route currently on an aircraft’s Flight Management System (FMS).  It may or may 
not be the same as the ERAM flight plan route. 
Use the Enable route checkbox to display or remove the route lines. 
Click the Apply or Ok button on the Properties dialog once all desired changes have 
been made.  
Selecting to display route lines as the default for all targets may result in a cluttered 
display. 
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Histories depict a specified number of previous target positions.  
The History panel has three components: 
The Enable history checkbox is used to specify whether histories will be displayed as 
the default for all targets. 
Enter a numeric value in the Dot number input box to specify the number of histories to 
display. 
Enter a numeric value, in seconds, in the Interval (sec) input box to specify the time 
interval between history updates. 
Click the Apply or Ok button on the Properties dialog once all desired changes have 
been made.  
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A halo is a circle around a target position symbol that serves as a distance reference.  
The Halo panel has two components: 
The Enable halo checkbox is used to specify whether halos will be displayed as a 
default for all targets. 
Enter a numeric value in the Halo Separation (nmi) input box to specify the halo radius 
(i.e., the distance from the target position symbol to the circle). 
Click the Apply or Ok button on the Properties dialog once all desired changes have 
been made.  
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A target label provides information about the target.  There are two types: 

• Full Data Block (FDB) always displays callsign, altitude, computer identification 
number (CID), aircraft type, heading and speed.  It can also time-share with the 
aircraft type to indicate situations such as handoffs or emergencies. 

• Limited Data Block (LDB) provides callsign and altitude only. 
The Label panel has four components: 
The Enable label checkbox is used to specify whether labels will be displayed as a 
default for all targets.  This is the typical choice. 
When the Rules-Based Selection checkbox is checked, all targets assigned to the 
Ghost Pilot will display an FDB and all other targets will display an LDB.   
The Format drop-down menu is used to select which type of data block (Pilot FDB or 
Pilot LDB) is displayed for all targets when the Rules-Based Selection checkbox is not 
checked. 
The Orientation checkbox is used to specify the location of the target label relative to 
the target position symbol. 
Click the Apply or Ok button on the Properties dialog once all desired changes have 
been made.   
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The target color can be selected for seven different target states using the previously 
described steps.  The target states are: 

• Controlled by this position – Targets assigned to your Ghost Pilot position. 

• Controlled by this sector – For scenarios with multiple Ghost Pilots, targets 
assigned to other Ghost Pilot positions in your sector. 

• Not controlled – Targets not controlled by your position or sector.  Typically 
system traffic. 

• Check-in Required – An indication that the Ghost Pilot must contact the controller 
via voice. 

• Emergency – A special case when the target is squawking a special beacon 
code. 

• Highlighted – When the Ghost Pilot holds down the left mouse button over a 
target. 

• Selected – When the Ghost Pilot clicks on the target position symbol or label. 
Click the Apply or Ok button on the Properties dialog once all desired changes have 
been made.  
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Most default target characteristics are set up using the Target tab on the Properties 
dialog.  The one exception is the target font, which is set using the Target Label Font 
Chooser dialog.  Select the Font icon in the Display toolbar to open the dialog. 
The target label font for all targets can be set using the same steps as previously 
described. 

1. Select a font. 
2. Select a size. 
3. Select a font style. 
4. Click on Ok or Apply. 

Note that the font selection also affects the text of the Selected Aircraft Information Area 
(SAIA). 
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Target characteristics can also be specified for a single target.    
The target label can be repositioned. 
The Data Block Management menu can be used to: 

• Display/remove the target label 

• Display/remove histories 

• Display/remove the route line 

• Display/remove the halo 

• Change the target label format (FDB or LDB) 

• Access a Target Properties dialog 
The Target Properties dialog can be used to customize target characteristics for the 
selected target. 
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Click-and-drag to move the target label.  To do so: 
1. Hold down the left mouse button over the label.  The cursor will change to 

indicate it is in “move” mode. 
2. While continuing to hold down the left mouse button move the cursor to the 

desired location. 
3. Release the left mouse button. 
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Right-click on the target position symbol of the desired target to open the Data Block 
menu. 
There are checkboxes to display/remove the following: 

• Label 

• Histories 

• Route 

• Halo 
When a checkbox is checked/unchecked, the change will take immediate effect and the 
menu will close. 
The Label format option is used to select the desired label format for that target. 
The Target properties… options opens the Target Properties dialog for the selected 
target. 
The Hide target and Copy target… options are covered in a later lesson. 
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The Target Properties dialog behaves just like the Targets tab in the Properties dialog 
but only affects the selected target. 
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In this section, we will cover various ways to filter which targets are displayed on the 
map. 

The System Traffic icon on the Display toolbar is used to include or exclude (i.e., filter) 
the display of targets with no assigned Ghost Pilot (i.e., system traffic). 

The Target Filter dialog provides options to filter targets based on the following criteria: 

• Position tab – Which Ghost Pilot has control of the target 

• Sector tab – Which sector will be working the target 

• Callsign tab – Target callsign 

• Altitude tab – Target altitude 
Filtered targets/data blocks are forced to the display when the target is in handoff 
status.  Once the handoff indications clear, the filter will be re-applied. 
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Many scenario developers include unassigned targets to add realism to the exercise by 
simulating adjacent sector or VFR traffic. 

• Since the Ghost Pilot will never interact with these targets, the scenario 
developer does not assign a Ghost Pilot to them.  

• Targets that do not have an assigned Ghost Pilot are called “system traffic.”  

• The default target color for system traffic is gray. 
A Ghost Pilot can filter system traffic by clicking on the System Traffic icon on the 
Display toolbar.  When the icon is selected (i.e., gray outline), system traffic will be 
displayed. 
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The Target Filters dialog is accessed by clicking on the Target Filters icon on the 
Display toolbar. 
The dialog contains four tabs: 

• Position 

• Sector 

• Callsign 

• Altitude 
Filters can be used individually or in any combination. 
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Scenario developers can assign each target to a Ghost Pilot position.  In many cases, 
the scenario developer will determine that two or more Ghost Pilots are needed and will 
divide targets to balance the workload.   
The Position Tab is used to filter targets based on which Ghost Pilot is assigned the 
target. 
The Enable position filter checkbox is used to enable or disable the Position filter.  
This checkbox will be automatically checked if you check or uncheck any of the tab 
options.  This is true of the Sector, Callsign, and Altitude tabs as well. 
The Show system traffic checkbox is used to display or hide targets that are not 
assigned to a Ghost Pilot. 
There will be a separate checkbox in the body of the tab for each Ghost Pilot position.   
A check in the Visible checkbox next to a Ghost Pilot means the targets assigned to 
that Ghost Pilot will be displayed. 
Click on Ok to implement the changes. 
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Although rare, scenario developers can create scenarios with multiple ERAM sectors. 
The Sector Tab is used to filter targets based on which sector has track control of the 
flight (i.e., which controller is working the traffic). 
The Enable sector filter checkbox is used to enable or disable the Sector filter.  Any 
changes on this tab will enable the checkbox. 
In a multiple-sector scenario, there will be a separate entry in the body of the tab for 
each ERAM sector with assigned Ghost Pilots.  This example shows a single sector, 
sector 16. 
A check in the Visible checkbox next to a sector means the targets being controlled by 
that sector will be displayed. 
Click on Ok to implement the changes. 
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The Callsign Tab is used to filter targets based on their callsign. 
The Enable callsign filter checkbox is used to enable or disable the Callsign filter.  Any 
changes on this tab will enable the checkbox. 
There will be a separate entry in the body of the tab for each target.  This example 
shows six targets.   
A check in the Visible checkbox next to a target callsign means that target will be 
displayed. 
This is another method for restoring hidden targets, which we’ll cover in a later lesson. 
Click on Ok to implement the changes. 
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The Altitude Tab is used to filter targets based on their altitude. 
The Enable Altitude Filter checkbox is used to enable or disable the Altitude filter.  Any 
changes on this tab will enable the checkbox. 
To establish an altitude range, enter a lower altitude limit and an upper altitude limit.  
Only targets in that altitude range will be displayed.  In this example, only targets at or 
above FL230 and at or below FL370 will be displayed.  Altitude is always in hundreds of 
feet. 
If altitude filters are in effect, the Status Information Bar will list the upper and lower 
limits. 
Click on Ok to implement the changes. 
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As described earlier, ATPilot has nine views that provide scenario information, and can 
be used to perform various functions. 
Most views can be customized in the following ways: 

• Displayed or removed  

• Moved or resized 

• Selection of which view columns (i.e., fields) are displayed 

• Sequence of the view columns (i.e., fields) 

• Sorting the entries in the view 
The Active Aircraft List and Future Aircraft Lists can also be customized as follows: 

• Automatically deleting old entries from the view (i.e., Auto Compress) 

• Selecting to display multiple lines for an entry 
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The Views toolbar is used to manage which views are displayed. 
Click on the desired icon to display or remove the view. 
When a view is being displayed the corresponding icon will have a gray outline.  In this 
example, the Active Aircraft List and the Selected Aircraft Information Area views are 
being displayed. 
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Click-and-drag on the view header to move a view.  Specifically: 
1. Move the cursor to the view header. 
2. Hold down the left mouse button.   
3. While continuing to hold down the left mouse button, move the view to the 

desired location. 
4. Release the left mouse button. 

To resize a view: 
1. Move the cursor to a view corner or edge until it changes shape to indicate 

“resize” mode. 
2. Hold down the left mouse button.   
3. While continuing to hold down the left mouse button, move the cursor until the 

view is at the desired size and shape. 
4. Release the left mouse button. 

These are standard window move and resize methods.  
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The Active Aircraft List, Future Aircraft List, and CPDLC Message view allow the Ghost 
Pilot to customize the displayed information. 
To do so: 

1. Right-click on any column name (i.e., field name). A pop-up menu listing all 
available fields will appear. 

2. Check or uncheck the desired field.  Note that the change is implemented 
immediately and the pop-up menu disappears.  This means that, if this method is 
used, only one field at a time can be added or removed. 

Click on the Show/Hide…option to open the Column Show/Hide dialog.  Use this dialog 
to make multiple changes at once.  Click on Ok or Apply once all desired changes are 
made. 
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The sequence in which the columns are presented can be customized.  To do so: 
1. Position cursor over the desired column name. 
2. Click-and-drag right or left to the desired location. 

Note that the entire column will move. 
In this example, the CheckIn column is being moved so it appears next to the ACID 
column. 
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The default sort order is based on the time at which a target is activated in the exercise.  
The last target to be activated is the last entry in the list. 
To sort entries by other criteria:  

• Click on the column name to sort by that criterion. 

• A triangle pointing up indicates the entries are being sorted alphanumerically in 
ascending order.  

• Click the column name again to sort in descending order. 

• Up to three levels of sorting can be selected.  The arrows that appear in the 
column name change in size with the largest one being the first criteria, the 
second largest the second criteria and so on. Selecting a fourth sort column 
removes the first sorting that was selected. 
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When a target drops from an exercise, the data in that target’s Active Aircraft List entry 
is erased and a blank row is left in its place. The same behavior will be seen in the 
Future Aircraft List when a target is moved to the AAL.  The system can be set to 
automatically remove the blank space. This is called auto-compress.  To enable auto-
compress: 

1. Right-click on any field. 
2. Select Auto-Compress from the drop-down menu. 

New entries in the Active and Future Aircraft Lists can be automatically sorted by the 
currently selected sort criteria.  This is referred to as auto-sort.  If Auto-Sort (Sort Policy) 
is not selected, new entries will appear at the bottom of the list. 
To enable auto-sort: 

1. Right-click on any field. 
2. Select Auto-Sort (Sort Policy) from the drop-down menu.  A check mark 

indicates that auto-sort is selected. 
If Auto-Sort (Sort Policy) is selected, entries are automatically auto-compressed. 
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Entries in the Active and Future Aircraft List views can be toggled to display data on one 
or two lines. To change the number of lines displayed in entries: 

1. Right-click anywhere in the view. 
2. Select MultiLine Formatting to change the number of lines displayed.  A check 

mark indicates two lines are being displayed. 
Selecting two lines provides all available information but fewer targets will therefore be 
listed.  (The view does not expand or contract.)  Selecting one line eliminates some 
information, but lists more targets. 

In this example, two lines are being shown.  If MultiLine Formatting is unchecked, the 
second row of each entry is eliminated. 
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In this section, we will describe how to set display brightness levels. 
Brightness levels are managed using the Brightness dialog.   
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The Brightness dialog is opened by clicking on the Brightness icon (i.e., light bulb) on 
the Display toolbar. 
Another option is to open the Properties dialog, by clicking on the Properties icon on 
either the Display toolbar or the Map Display menu, and selecting the Brightness tab. 
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There are slider bars that control the brightness for the following panes: 

• Lines 
• Weather 
• Targets 
• Map 

The scroll bar must be used to access the slider bar on the Map brightness pane. 

The specific elements affected by the brightness change are displayed in the panel 
below the slider bar.  The elements in the panel will change brightness level as the 
slider bar is moved. 

Click Ok or Apply once all brightness levels are set. 
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In this section, we will describe how to show or hide toolbars, and how to move them. 
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The Toolbars menu on the Menu Bar can be used to show or hide any of the five 
toolbars. 

Check the toolbar to display it, or uncheck to remove it from the display.  Using a 
checkbox implements the change immediately and removes the menu.  This means 
that, using this method, only one toolbar can be displayed or removed at a time. 

Select the Show/Hide… option to display a Show/Hide dialog used to make multiple 
changes at one time. 
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Toolbars can be positioned anywhere along the edge of the display or anywhere on the 
map.  Note that there are slots (i.e., containers) for toolbars along the edges. 
To move a toolbar: 

1. Position the cursor over the toolbar handle. 
2. Click-and-drag the toolbar to the desired location using the handle.  As you move 

the mouse, the toolbar outline will move. 
3. To move the toolbar to an edge, wait until the outline edges turn yellow, and then 

release the left-mouse button. 
4. To move the toolbar to a location on the map, drag the toolbar outline to the 

desired location, then release the left-mouse button. 
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Once a Ghost Pilot has set up the display, they can save the settings in a Preference 
Set, or pref set.  The pref set can be used with any exercise. 
The display can also be reset to the default settings (i.e., the settings when an exercise 
first starts). 
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Pref sets are managed from the File menu on the Menu Bar. 

The three options are: 

• Load Preferences… 

• Save Preferences… 

• Reset Preferences… 
As mentioned, the Reset Preferences… option will return all display settings to their 
default values.  These are the values applied when an exercise starts. 
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To load a pref set: 

1. Select the Load Preferences… option from the File menu.  The Load 
Preferences dialog will open. 

2. Double-click on the desired pref set name. 
Since each facility has many Ghost Pilots, it can be useful to create an individual folder 
for each Ghost Pilot.  To access a folder: 

1. Double-click on the desired folder. 
To create a new folder: 

1. Click the New Folder icon. 
or 
Right-click in the list area and select New Folder. 

2. Enter a folder name. 
To exit a folder and return to the next level, use the Up One Folder icon. 
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To save a pref set: 

1. Select the Save Preferences… option from the File menu.  The Save 
Preferences dialog will open. 

2. Navigate to the desired folder. 
3. Enter a pref set name. 
4. Click on Save. 

If a file exists with the same name, a warning will be displayed. 
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After completion of this exercise, this lesson will resume in the classroom.  Your 
instructor will provide the details. 
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Part Task Scenario 1: 
 

 
Purpose 

 
To practice all tasks related to setting up the Ghost Pilot 
display and to save preference sets. 
 

 
Materials 

 
The instructor will use the Part Task Scenario1 checklist.  No 
student handouts are required. 
 

 
Directions 

 
A locally developed scenario should be loaded and ready to 
start in the TTL.  Requirements for the scenario have been 
provided to the facility.   
 
No controllers are needed.   
 
No headsets are needed. 
 
Instructors should use the checklist to step through all the 
functionality to be practiced.  Instructors should assist students 
as necessary. 
 
Approximate duration of the exercise is 45 minutes.  
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